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Study Guide Overview: 

We have designed a variety of tools for students to prepare for the ACA exam. This document is designed to 
pool all of these tools together in one location so you can share them easily with your students. 

Top 10 Exam Tips 

1. Read carefully and follow the directions. 

2. Focus on what you know. If you aren’t confident with a task or question, mark it for review and 
move on. 

3. Type in values so you are precise and save time. Make sure to hit enter or click off to make sure the 

value is entered. 

4. The exam uses hex or RGB numbers so get used to typing these into the color dialog box. 

5. Don’t wait time rendering. If you want to preview an animation, scrub. 
6. If you have to render, adjust the work area so you only have to render the specific part of the timeline. 

7. Complete the entire task before clicking “Next” 
8. Use After Effects for personal projects before taking the exam. This will give you real world practice. 

9. Study the vocab, tools/buttons icons and panel interface. 

10. Take the night before the exam off (no studying). Get plenty of rest that night. Each healthy on 

the exam day and go for a 10-20 minute walk before taking the exam. 

 

Certification Objectives 

All the exams are broken down into five objectives. You can download a pdf of the After Effects objectives 

at http://bit.ly/ae-objectives. I will use these objectives to organize the study guide. 

 

Objective 1: Working in the Visual Effects and Motion Graphics Industry 
This objective covers critical concepts related to working with colleagues and clients, as well as crucial legal, technical, 

and design related knowledge. 

1.1 Target Audience: “a particular group at which a film, book, advertising campaign, etc., is aimed.” Google 

For motion graphics artist this means choosing media and animation styles that match the specific audience. 

 
1.2 Project Plans: The key terms include “Pre-production: shot list, script writing, storyboarding, design 

compositions or sketches, style guides, etc.” Practice using these tools to plan your projects!

http://bit.ly/ae-objectives
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1.3 Copyright, permissions, and Licensing: Review the following copyright terms, talk about how to get 

permissions/releases for your actors and locations. “Creative Commons, public domain, intellectual 
property, derivative work, commercial use, attribution, work for hire, fair use/fair dealing, etc.” 

 
Creative Commons Licenses: https://creativecommons.org/licenses/ Make sure to review these icons. 

 
 

 

Basic Creative Commons: Often combined with the rest of the Icons. 

Example:  

 

 

Attribution CC By: This license lets others distribute, remix, tweak, and build upon 

your work, even commercially, as long as they credit you for the original creation. 

This is the most accommodating of licenses offered. Recommended for maximum 

dissemination and use of licensed materials. 

 

 

ShareAlike: This license lets others remix, tweak, and build upon your work even 

for commercial purposes, as long as they credit you and license their new creations 

under the identical terms. This license is often compared to “copyleft” free and 
open source software licenses. All new works based on yours will carry the same 

license, so any derivatives will also allow commercial use. This is the license used 

by Wikipedia, and is recommended for materials that would benefit from 

incorporating content from Wikipedia and similarly licensed projects. 

 

 

NoDerivs CC by-ND: This license allows for redistribution, commercial and non- 

commercial, as long as it is passed along unchanged and in whole, with credit to 

you. 

 

 

NonCommercial: This license lets others remix, tweak, and build upon your work 

non-commercially, and although their new works must also acknowledge you and 

be non-commercial, they don’t have to license their derivative works on the 
same terms. 

 

 

NonCommercial-ShareAlike: This license lets others remix, tweak, and build upon 

your work non-commercially, as long as they credit you and license their new 

creations under the identical terms. 

 

 NonCommerical-NoDerivs: This license is the most restrictive of our six main 

licenses, only allowing others to download your works and share them with others 

as long as they credit you, but they can’t change them in any way or use them 
commercially. 

https://creativecommons.org/licenses/
https://creativecommons.org/licenses/
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1.4 Key Terminology/Tools: Review the following terms. 

● Digital Video: Frame rate, aspect ratio, safe zone, image and video resolution, file formats, video 

codecs, pixels, rendering, audio sampling rates, 

etc. 

● Color Management: White balance, color 

grading vs color correction 

● Audio: Audio levels, wave forms, decibels (how 

volume is measured), kHz (sampling rate) 

 
1.5 VFX and Design Principles: Review the following terms. 

● Composition: lighting, color, scale and perspective, working in 3D space, rotoscoping, etc. 

● Design Principles/Guidelines: space, line, shape, form, color, texture, emphasis/focal point, 

unity/harmony, variety, balance, alignment, proximity, repetition, rhythm, scale, movement, negative 

space, gestalt, etc. 

● Animation Principles: easing, squashing, stretching, anticipation, staging, straight-ahead action 

and pose to pose, follow through and overlapping action, slow in and slow out, arc, secondary 

action, timing, exaggeration, solid drawing, appeal, etc. *I bolded the concepts that I really hammer 

in class. 

 

Objective 2: Project Setup and Interface 
This objective covers the interface setup and program settings that assist in an efficient and effective workflow, as well as 

knowledge about importing digital assets for a project. 

2.1 Composition Settings: The basic contain for all your animations will be a composition. You should have 

a solid understanding of how to create and modify the composition settings.
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Key Vocabulary: frame rate, resolution, duration, dimensions, aspect ratio, presets, shutter angle (advanced 

tab), background color, naming compositions, lock/unlock aspect ratio, etc.
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2.2 Navigate, organize workspace: This is a key one because it focuses on the interface! You should 

be familiar with the primary panels and their key buttons, the tools and how to change workspaces. 

Standard Workspace Overview: These are most of the core panels. You should be able to both identify them 

and match a definition. 

 

 
Key Panels 

Menu Bar: The horizontal bar, located at the top of the screen below the title bar, containing drop-down 

menus. 

Tools Panel: The horizontal bar, located at the top of the screen below the menu bar, containing all the tools 

and options. 

Project Panel: The panel on the left that contains all your media and compositions. Get in the habit of keeping 

this organized! 

Timeline: The panel typically on the bottom that contains all the layer information, modes and switches and 

keyframe information. Vertically it allows you to control the “arrangement” of how the media is stacked on top 
of each other. Horizontally it allows you to control when things happen in time. 

Composition: The panel typically in the center that contains your visual media and where you will playback 

your animations. 

Effects & Presets: The panel typically on the right that contains all the effects and presets. Learn how to use 

the “search” box to find things quickly for the exam. 
Effects Control: This panel is not pictured but usually is nested with the Project Panel. It allows you to adjust 

effects once they are applied to elements within your composition.
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Tool Bar 
 

 

 
Selection 

 

 
Hand 

 

 
Clone Stamp 

 

 
Zoom 

 

 
Rotate 

 

 Eraser 
 

 
Pan Behind 

 

 
Brush 

Nested Tools: Some of the tools are nested. You will need to click and hold on the tool to expose the rest of the tools. 
 

 

Shape 
 

 

Camera 

 

 

Pen 
 

 

Puppet 

 

 

Type 
 

 

Roto Brush 

 
Project Panel 

 

 

Preview: if you click on your media the preview will 

provide key information about the clip. 

Organization: Make sure you know how to create folders, 

rename and rearrange items. I like to create a folder for 

my comps and a folder for my media. 

New Comp Button: This is a quick way to create a new 

comp but my favorite use it to drag a clip onto this button 

when I want to start a new comp with the same 

properties as the clip (resolution, frame rate, duration) 
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Composition Panel 

 

Magnification: This allows you to zoom in and out of the composition. I usually use the wheel on my mouse for this. 

Grid and Guides: This allows you to turn on the Title/Action Safe guide. 

Mask and Shape Visibility: I usually leave this turned on so I can see the edges of my masks. 

Resolution: This allows you to control the resolution of the play back (reduce if playback is choppy) 

Transparency: This allows you to toggle transparency on and off. If it is on you will see the checked background, when it 

is off you will see the color you selected as the comp background.
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Character Panel 
 

 

Critical panel usually located on the right. Make sure you 

understand the following: 

Font: change the font 

Color: The top square in the fill color and the bottom one 

with the hole is the stroke color 

Leading: This allows you to control the space between 

lines 

Tracking: This allows you to control the space between a 

group of characters 

Kerning: This allows you to control the space between 

two characters. 

Caps: You have All Caps and Small Caps 

Scripts: You have Superscript and subscript (makes the 

text small and either high or low) 

Effect Control Panel
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The Effect Control panel is usually nested with the project panel. If 

you don’t see it you can always open panels from the Window Menu. 
 

Reset: This is great if  you mess up and want to start over. 

Reveal Arrow: These are all over the After Effects interface. They 

allow you to reveal more options. 

Values: Colored numbers indicate values that can be changed. I 

recommend clicking and typing values for the exam but you can also 

scrub these. 

Stop Watch: If you see a stopwatch that means the value can be 

changed/animated over time. 

Drop Down Menus: Many of the effect options can be accessed by a 

drop down menu. 

 

Configure Application Preferences 
Mac: Preferences is under the After Effects Menu | PC: Preferences is under the Edit Menu 

Key Preferences 

Auto-save: I advise my kids to set this to “every 5 minutes” 

Appearance: Let’s you use a dark or light appearance to the interface 

Grids & Guides: Let’s you change the spacing and color of the grid and guides 

Media & Disk Cache, Memory, Previews: These let you control how After Effects will manage the memory and file 

saving



After Effects CC18|19|20 Study 

 

 

 

2.3 Non-visible Design Tools 
Navigation: Here are the essential navigation techniques 

Panning: Hold spacebar down to get the hand/pan tool 

Zooming: Use your mouse wheel | Shift + / will fit your view to the comp window 
Play/Pause: Tap space bar 

J/K: These jump forward and backward between keyframes 

Page Up/Down or Ctrl/Cmd + arrows: Move one frame forward or backward 

~ (Tilde): Maximize the panel your mouse is over 

Ctrl + ‘ Show/hide grid 
 

Safe Margins 
The After Effects safe margin guides come with both 4:3 and 16:9 safe guides. Each has a title and action safe 
margins. 

 

 

2.4 Import Assets 
Importing Layer Files: When you import a layered file like Photoshop or Illustrator you need to pay attention 
to the import dialog options. *If you want to animate individual elements of an Illustrator file, make sure they 
are on their own layers! 
Adobe Dynamic Link: Files that use dynamic link are embedded in a way that allows you 
to change one and see these changes reflected in the other document. 
Replace Footage: If you move or rename a file that you have already imported it will break 
the link. If you see this icon in the comp or project panel, right click and “Replace footage” 
Proxies: This creates a low res proxy file that will speed up editing and swapped out for 
rendering. 
Image Sequences: This allows you to import timelapse and stop motion sequences!
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Interpreting Footage: This allows you to override After Effects best guess at setting each file’s pixel aspect 
ratio, frame rate, color profile, and alpha channel type. I often need to do this with stop motion image seq. 

Premiere Pro: You can import all sequences, individual sequences and audio files from a Premiere Pro file. 

 

Objective 3: Organizing Video Projects 

3.1 Use the Timeline Mange Layers 

Current Time: This is a critical control especially on the ACA exam. It allows you to move to a specific point in time. 

Zoom bar/Zoom Control: Both of these allow you to zoom in/out of the timeline. I like using the -/+ keys to do this. 

CTI (Current Time Indicator): This shows you were in time you are viewing in the composition panel. 

Work Area: This controls the area that will be rendered. You can also use it to quickly trim your comp. 

Marker Button: This allows you to add markers to the timeline. Double click them to edit a marker. 

Toggle Switches/Modes: This allows you toggle between your switches and modes. 

 

Close Up with Important Switches 
 

 

Eye Ball: Hide/show layer 

Mute: Turn sound on/off 

Solo: Hides all other layers 

Lock: Lock/unlock layer 

Layer Color: This allows you to change the layer 

color and can be used to help organize the comp 

Shy: This allows you to temporarily hide a layer in 

the timeline while keeping it visible in the comp! 

Motion Blur: My favorite switch to turn on for 

any element that moves! 

Parent: This allows you to inherit animation from 

one layer to another saving tons of time! 

 

Close Up with Important Modes
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Blend Modes: This allows you to blend the layer 

with other layers. You can also right click on the 

layer to change the blend mode of a layer. 

Track Matte: This is an invisible layer that is used 

to control the opacity of the layer directly 

beneath it. 
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Close Up Switches 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

Layer Types 
 

 
Descriptions are listed in the same order as 
the icons in this image. 

 

*3D These types of layers will only 
interact with layers that have the 3D 
switch turned on! 

This is critical to be able to identify the layer type by the 
symbol. Luckily, most of them make sense! 
Adjustment: This is an invisible layer that you can apply an 
effect to and it will affect all the layers below it. 
Camera: This lets you control the perspective of how the 
comp is viewed. It can be animated! *3D 
Light: This allows you to control how light effects elements in 
your comp. *3D 
Text: Layer that has text on it 

Solid: This is a solid color plane but you can apply effects to 
make them look cool. 
Null: This is an invisible layer that you can apply 
animation/effects and then parent it to other elements. 
Shape: This is a layer with one or more shapes 
Photoshop: This is a single layer from Photoshop 
Illustrator: This is a vector layer from Illustrator 
Mpeg: This is a video clip. Notice how there is a speaker icon 
indicating that it has sound. 

 

Layer Tips 
Stacking Order: Just drag layers up or down to adjust their stacking order. 1 is always the top layer. 
Rename: Select a layer and press “Enter/Return” to rename. You can also right click/Rename 
Layer Color: The little boxes next to the layer stacking number controls the color of the bar in the timeline. 
Just right click on the little box to change the color. 
Layer Properties: Clicking the little arrow next to the little colored box will reveal/conceal the layer properties. 

Layer Controls: Make sure you understand the hide/show, mute, solo, lock/unlock controls!
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Selecting Multiple Layers: Hold Ctrl/Cmd and click on the layers you 
want to select 
Pre-Composing: Sometimes your timeline gets really busy so to 
simplify things you can combine layers into a new (nested) 
composition using the “Pre-Compose” function by selecting the layers 
and the right clicking. 

Render Order: After Effects renders the layers from the bottom to the 
top.
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3.2 Modify Layer Visibility using opacity, blending modes, and masks 

Layer Controls: Make sure you understand the hide/show, mute, solo, 
lock/unlock controls! 
Opacity: This is one of the basic transformation properties (T) and can 
be animated. 
Blend Modes: This can be control in the mode options or right click 

 

Masking 
This is a big part of After Effects. Here are some tips: 
Layer/Mask/New Mask: If you want to add a mask that matches the 
size of the layer it is easier to do it from the menu. 
Mask Tools: If you select a layer and then use any of the 
shape tools or the pen tool you will automatically create a 
mask for the selected layer. 
Mask Properties: Get comfortable modifying the mask 
properties. I often feature a mask to soften the edges. 

 
 
 

Mask Visibility Button: Make sure that you have the 
Mask and Shape Path Visibility button turned on. 

Anatomy of a Mask
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Objective 4: Creating and Modifying 

Visual Elements 

4.1 Core Tools and composition 

Most of the visual elements in my motion graphics are usually media I import but you can create complex 
visual elements using tools in After Effects. 

Shape Tips 

Deselect Layers: To create a shape, make sure no layers are selected so you don’t accidentally make a 
mask! 
Shape Layers: When you create a shape it automatically makes a shape layer. 1 - Rename this to keep 
organized 2 - You can have multiple shapes one shape layer (open the layer to reveal them) 
Shape Modifiers: Holding shift forces the shape to be proportional. Arrows will modify the polygon and star 
shapes. 
Shape Fill/Stroke: The fill and stroke properties are on the Tool Bar. Type in color values! Click on the words 
Fill or Stroke to get more options. 

 
Shapes from Vector Layers: I often convert my vector layers from Illustrator 
into shape layers. You can do this by right clicking or the Layer menu and then 
Create/Create Shapes from Vector Layer 
Pen Tool: This is the most versatile tool for creating complex shapes. Make 
sure you practice making and modifying shapes and masks with the pen tool. 

 

Tips on Placing Assets into a Composition 
Place Media into Comp: If you want the media centered in the comp, drag it to the timeline instead of the 
comp window. 
Fit To: If you want the media to fill the comp, right click and select Transform/Fit to Comp Width or Height (If 
you select “Fit to Comp” your media will be distorted. 
Align Panel: I use this all the time to align center objects in the comp or align multiple elements. If you don’t 
see the Align panel, just go to the Window Menu to pull it up. 

 

4.2 Add, manipulate, and animate text 
Text Tips 

Point Vs Paragraph Text: This is the same in all Adobe applications. Click and drag if you want to create a 
paragraph area that will automatically wrap. Single click if you want to create a single like of text. 
Text on a Path: You can attach your text to a path and then animate it using the mask path function. 
Character Settings: You should understand font, size, style, kerning, tracking, leading, scale, cap and 
script options. 
Paragraph Settings: You should understand alignment, line length and spacing/indenting options. 

 

Animating Text 

Preset Animations: this is a great place to start. Try the “Browse Presets” from the Effects & Presets panel 
options button. This will open previews in Adobe Bridge. 
Transformation Properties: Of course you can animate text using any of the basic transformation properties. 
Text Animators and Selectors: Reveal the text properties and click on the “Animate” arrow to add a text 
animator.
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Trimming Tips 

4.3 Trimming Footage

Moving: It is easy to move a layer on the timeline by simply clicking and dragging it right or left 

Trimming: You can either trim a layer with the in/out points in the footage or layer panels. You can also 
trim a layer by clicking and dragging the end of a layer (cursor will turn into a black double headed arrow) 
Splitting Layer: This is a great way to apply different effects or blend modes to a layer at different times. 
Move the CTI to specific time (use Current Time control to be precise on the exam). Select the layer you want 
to split and go to the Edit menu to select “Split Layer”. 
Lift/Extract: For those of you familiar with Lift and Extract from Premiere Pro you can use the Work Area and 
the Edit Menu to perform the same function as in Premiere. 

Layer/Footage Panel 

 

Trimming Footage: If you double click on a video clip in the project panel it will open in the footage panel, 

where you can trim the clip by setting in/out points. You can also 
 

4.4 Modify digital media within a project 
Transform Tips 

Transform Menu: Right click on layer or the visual element in the comp and select Transform/option to 
precisely transform. This is the best way to flip something. 
Transform Controls: Just like the rest of the Adobe applications, use the Selection tool and the control 
handles to move and resize something. Hold Shift to keep things proportional. 
Rotate Tool: You can use the rotate tool rotate an object around it’s anchor point. 
Pan Behind Tool: You can use the Pan Behind tool to change the anchor point. 

 
Speed Tips 

Time Menu: Right click on layer or go to the Layer Menu and Time to get to the speed/time options. 

● Time Stretching: This is when you change the speed to an entire layer. Try the “Timewarp” effect. 
● Time Reverse: This is a quick and easy way to reverse video or animation playback! 

● Time Remapping: This allows you to use keyframes and easing control the playback speed 
and direction within a clip. 

● Freeze Frames: Freeze the current frame for the duration of the layer 
 

4.5 Basic Reconstruction 
Auto Correction Tools 

Stabilization: The “Warp Stabilize” effect is the best way to stabilize shaky footage 

Color: There are tons of great color effects but my current favorite is the Lumetri Color effect. Go to the 
Effects/Color Correction/Lumetri Color option to apply it to a video clip. 
Color Correction: I like using the “Basic Correction” section of the Lumetri Color effect. This is great to fixing 
white balance and tonal issues like exposure.
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Color Grading: I like using the “Creative - Looks” or “Curves” section of the Lumetri Color effect. This is great 
for giving your clips a specific “Look” or telling your story through color. 

 

4.6 Add and modify effects and presets 
Effects Tips 

Search: Use the search box in the Effects & Presets panel to quickly find an effect. 
Values: Once you apply an effect to a layer you will need to change some of the properties. Click on the blue 
numbers to type in the exact values on the exam. 
Stopwatch: If you see a stopwatch that means you can animate the values. I recommend using the effecs 
properties down in the timeline instead of the Effect Controls panel when you need to animate a value over 
time. Select the layer and press “E” to reveal the layers effects properties. 

 

3D Tips 
3D Layer Switch: Make sure to turn on the 3D switch for any layers you want to have a camera or light effect, 
and if you want to extrude a shape or text. 
2.5 D: Since After Effects comps may include video clips and other media that can’t be extruded these will 
be 2D but can move through 3D space. Editors usually animate the camera vs animating these elements. 
Camera Properties: The cool thing about using a camera layer is that you can reveal the “Camera Options” in 
the timeline panel to set/animate all the camera properties like zoom, depth of field, focus distance, etc. 
3D Controls: Lights and Camera need to be positioned within 3D space so you will have three controls both in 
the transformation properties and in the comp window. These are the standard blue, red and green arrows you 
will see in any 3D program. 

 
 

Composite Tips 
Keylight: This is a powerful chroma-key effect that is widely used in the industry. 

*Masking and Mattes have already been covered. 

 

Adjustment Layer Tips 
New Adjustment Layer: Go to the Layer Menu and then New/Adjustment Layer. It will be added directly 
above which ever layer is selected. 
Stacking Order: Adjustment layers all the layers below its stacking order. 

Masking: You can add a mask to an adjustment layer so it will only affect area within the mask.
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4.7 Create and Modify Keyframes for motion graphics 
Transformation Tips 
Transformation Shortcuts: You will need to access specific transformation properties so often that it well 
worth learning the shortcut for each transformation. *see table below 
Values: Make sure to type in values on the exam! 

Easing: This controls the speed into and out of keyframes. 
● Easy ease: ease into and out of keyframe 

● Easy ease in: Slows down (decelerates) as it reaches a keyframe (bus pulling into the bus barn) 

● Easy ease out: Speeds up (accelerates) as it leaves a keyframe (bus pulling out of the bus barn) 

Motion Paths: This allows you to control the path of an object as it moves across a composition. 
Spatial vs temporal interpolation: You can control both the speed (temporal) and location (spatial) of a 
moving object. Right click on a keyframe and select Keyframe Interpolation 

 

 

Graph Editor 
The graph editor is a powerful interface that allows an editor to fine tune animations using a graph. 
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Objective 5: Publishing Digital Media 

5.1 Prepare to publish (check for errors!) 

Layer Management: Make sure to review your layers to ensure that the correct layers export. 
Text 

● Spelling: There is no spell check in After Effects so carefully proof it. 

● Title Safe Area: Make sure all text is within the title safe area 

Resolution: You can easily check the resolution of a composition by clicking it in the Project panel and looking 
in the preview area. 

 

5.2 Export digital video to various file formats 

Native File (.aep): Make sure to save your After Effects file. I recommend keeping your media and After 
Effects files together so you can easily archive the entire project. 
Export Frames: You can easily export an individual frame or a series of still images. 

Photoshop Layers: Move the CTI to the time you want to export and then go to Composition/Save 
Frame As/Photoshop Layers 

 

Export Composition 
Rendering/exporting your video project into a new video file is the best way to share with a client. There are 
many ways to do this. 
Render Queue: This is a quick way to render a comp. 

● Render Settings: Make sure to review the options in this dialog box! This is where you set things 
like resolution and quality. 

● Output Module: This is where you will set the file format and format options 

● Duplication (plus symbol): This allows you to duplicate the comp in the render queue so you can 
export multiple versions with different settings. 

● Output To: This is where you tell After Effects where you want to export to and the file name. 

 
Premiere Pro Project: This allows you to create a new Premiere Pro project with the current composition 
Dynamically linked. 
Adobe Media Encoder: This will launch the Adobe Media Encoder and allow you to use all this powerful 
programs export functionality. 
Adobe Dynamic Link: This is a cool way to embed Premiere Pro/After Effects files within each other!
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Archive Project 
After Effects will has function that allows you to automatically collect all the media you used in a project and 
create a new folder that contains a new .aep file and copies of all the media! File/Dependencies/Collect Files 

Online Study Tools 

 
Quizlet Study Guides: 

My students use Quizlet to study for many of their classes so they asked me to build these study guides for them. Quizlet 

is a great way for your students to study independently, with a partner or in small groups. 

● File Formats Quizlet 

● Audio Terms and Tools Quizlet 

● Video Terms 

● Production Process 

● Copyright Quizlet 

● Creative Commons Icons 

● After Effects Tools 

● Layer Types and Controls 

● Buttons 

● Panels 

● Rendering 

● Animation Principles 

● Workspaces 

Quizlet Password: 20acatestprep16 

 

Quizlet Live Download app or go to https://quizlet.com/live 
 

Notes: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://quizlet.com/_2ee00h
https://quizlet.com/_2edyxy
https://quizlet.com/_6v2plf
https://quizlet.com/_2edziu
https://quizlet.com/_2eatio
https://quizlet.com/_6v1fu0
https://quizlet.com/_6v1gp6
https://quizlet.com/_6v2p1a
https://quizlet.com/_6v2j6h
https://quizlet.com/_6v2i8f
https://quizlet.com/_6v2klj
https://quizlet.com/_3m06ia
https://quizlet.com/_3lnhbf
https://quizlet.com/features/live
https://quizlet.com/features/live
https://quizlet.com/live
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Notes: 
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